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Safety

Before installing this product, read the Safety Information.

Antes de instalar este produto, leia as Informações de Segurança.

Pred instalací tohoto produktu si prectete prírucku bezpecnostních instrukcí.

Læs sikkerhedsforskrifterne, før du installerer dette produkt.

Lees voordat u dit product installeert eerst de veiligheidsvoorschriften.

Ennen kuin asennat tämän tuotteen, lue turvaohjeet kohdasta Safety
Information.

Avant d’installer ce produit, lisez les consignes de sécurité.

Vor der Installation dieses Produkts die Sicherheitshinweise lesen.

Prima di installare questo prodotto, leggere le Informazioni sulla Sicurezza.
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Les sikkerhetsinformasjonen (Safety Information) før du installerer dette
produktet.

Antes de instalar este produto, leia as Informações sobre Segurança.

Antes de instalar este producto, lea la información de seguridad.

Läs säkerhetsinformationen innan du installerar den här produkten.
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Statement 1:

DANGER

Electrical current from power, telephone, and communication cables is
hazardous.

To avoid a shock hazard:

v Do not connect or disconnect any cables or perform installation,
maintenance, or reconfiguration of this product during an electrical
storm.

v Connect all power cords to a properly wired and grounded electrical
outlet.

v Connect to properly wired outlets any equipment that will be attached
to this product.

v When possible, use one hand only to connect or disconnect signal
cables.

v Never turn on any equipment when there is evidence of fire, water, or
structural damage.

v Disconnect the attached power cords, telecommunications systems,
networks, and modems before you open the device covers, unless
instructed otherwise in the installation and configuration procedures.

v Connect and disconnect cables as described in the following table
when installing, moving, or opening covers on this product or attached
devices.

To Connect: To Disconnect:

1. Turn everything OFF.

2. First, attach all cables to devices.

3. Attach signal cables to connectors.

4. Attach power cords to outlet.

5. Turn device ON.

1. Turn everything OFF.

2. First, remove power cords from outlet.

3. Remove signal cables from connectors.

4. Remove all cables from devices.

Safety vii



Statement 2:

CAUTION:
When replacing the lithium battery, use only IBM Part Number 33F8354 or
an equivalent type battery recommended by the manufacturer. If your
system has a module containing a lithium battery, replace it only with the
same module type made by the same manufacturer. The battery contains
lithium and can explode if not properly used, handled, or disposed of.

Do not:

v Throw or immerse into water

v Heat to more than 100°C (212°F)

v Repair or disassemble

Dispose of the battery as required by local ordinances or regulations.
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Statement 3:

CAUTION:
When laser products (such as CD-ROMs, DVD drives, fiber optic devices, or
transmitters) are installed, note the following:

v Do not remove the covers. Removing the covers of the laser product could
result in exposure to hazardous laser radiation. There are no serviceable
parts inside the device.

v Use of controls or adjustments or performance of procedures other than
those specified herein might result in hazardous radiation exposure.

DANGER

Some laser products contain an embedded Class 3A or Class 3B laser
diode. Note the following.

Laser radiation when open. Do not stare into the beam, do not view
directly with optical instruments, and avoid direct exposure to the beam.

Class 1 Laser Product
Laser Klasse 1
Laser Klass 1
Luokan 1 Laserlaite
Appareil A Laser de Classe 1`

Safety ix



Statement 5:

CAUTION:
The power control button on the device and the power switch on the power
supply do not turn off the electrical current supplied to the device. The
device also might have more than one power cord. To remove all electrical
current from the device, ensure that all power cords are disconnected from
the power source.

1

2

Statement 8:

CAUTION:
Never remove the cover on a power supply or any part that has the
following label attached.

Hazardous voltage, current, and energy levels are present inside any
component that has this label attached. There are no serviceable parts inside
these components. If you suspect a problem with one of these parts, contact
a service technician.
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Chapter 1. Introducing the IBM Eserver BladeCenter
2-Port Fibre Channel Switch Module

This Installation Guide contains the following information about the IBM®

Eserver BladeCenter™ 2-Port Fibre Channel Switch Module:

v Setting up and installing your switch module

v Installing the IBM BladeCenter SAN Utility application

For installation details, see Chapter 2, “Installing and replacing a switch
module”, on page 11 and Chapter 3, “Information panel LEDs and external
Fibre Channel ports”, on page 21. For additional information, see the
instructions in your BladeCenter unit publications. The term IBM Eserver

BladeCenter 2-Port Fibre Channel switch module is referred to as switch
module and the term IBM BladeCenter SAN Utility application is referred to as
the SAN Utility throughout this publication.

Your switch module is a Fibre Channel component that contains a 16-port
switch application specific integrated circuit (ASIC). The ASIC provides two
external Fibre Channel user ports with which to connect to external storage
devices and 14 internal ports to connect to the BladeCenter blade server bays.
You can manage and configure your switch module through either a Telnet
connection to the embedded command line interface (CLI), or by using the
SAN Utility. The SAN Utility provides an intuitive graphical user interface
(GUI) that you can use to configure multiple switch modules through other
connected SAN devices from a single interface. You can install up to two
switch modules in a BladeCenter unit.

You can obtain up-to-date information about your switch module and other
IBM server products at http://www.ibm.com/eserver/xseries/.

The switch module has four labels: a safety certification label, a serial number
label, and two MAC address labels. The safety certification label is on the left
side of the switch module. The product name and serial number are on the
serial number label on the left side of the switch module. The first MAC
address label is on the information panel under the switch module external
port 1. The second MAC address label is on the right side of the switch
module. You will need this information when you register your switch module
with IBM. See Figure 1 on page 8 for the location of the switch module labels
that contain the MAC address and serial number information.
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Record your product information in this table

Product name: IBM Eserver BladeCenter 2-Port Fibre Channel Switch Module

Model number:

Media access control (MAC) address:

Open the shipping carton of the switch module and carefully unpack its
contents. The carton should contain the following items:

v One Fibre Channel switch module

v The IBM BladeCenter Documentation CD

v The IBM BladeCenter SAN Utility CD

v One diagnostic wrap plug

v The IBM Eserver BladeCenter 2-Port Fibre Channel Switch Module Installation
Guide (this book)

v Safety information flyer

Note: The illustrations in this document might differ slightly from your
hardware.

Specifications and features

This section provides a summary of the specifications and features for your
switch module.

Your switch module has the following features:

v Simple name server implementation

The simple name server is implemented as described in Fibre Channel
Generic Services (FC-GS-3). The simple name server requests and responses
are based on the Common Transport Interface (CTI) as described in FC-GS-3.
Name server database objects are defined as follows:

– Native Port Identifier (P_ID)

– Port Name (PN)

– Node Name (NN)

– Class of Service (CoS)

– Internet protocol (IP) Address (IP_A)

– Initial Process Associator (IPA)

– FC-4 Types (Type) and Port Type (PT)

– Symbolic Port Name (SPN)

– Symbolic Node Name (SNN)
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v Security

The switch module provides fabric security and interswitch link security.
Fabric security controls management access to the fabric. When fabric
security is enabled on all switches in the fabric, you must provide a user
name and password to access the fabric. Security is disabled by default.

v Firmware installation

Use the SAN Utility application to install and activate new firmware.

v Registered State Change Notification (RSCN)

The switch module supports RSCN as described in FC-FLA. RSCN enables
an agent to register for change events in the fabric and attached devices.

v Interoperability

The switch module is interoperable with FC-SW-2 compliant switches.

For more information, see the IBM Eserver BladeCenter Fibre Channel Switch
Interoperability Guide.

v Error detection

The switch module supports the following error detection methods:

– Cyclic redundancy check (CRC)

– 8-byte and 10-byte conversion

– Parity

– Long frame and short frame

– D_ID mismatch

– S_ID mismatch

v Frame bundling

The switch module provides the following frame bundling methods:

– No frame bundling - Intermix frames from different sources at will.

– Soft lockdown - Soft lockdown causes the switch module to wait for
either the sequence to be completed or a gap in the frame traffic to occur
before servicing requests from a different port.

v Configurable Fabric Address Notification

Fabric Address Notification (FAN), as described in FC-FLA, is sent out by
the fabric after an initialization event (usually a loop initialization port) to
each attached NL_Port. The purpose of the FAN is to inform the attached
NL_Ports of the fabric node name, port name, and fabric address.

Chapter 1. Introducing the IBM Eserver BladeCenter 2-Port Fibre Channel Switch Module 3



The following information is a summary of the specifications of the switch
module:

Table 1. Fibre Channel switch module specifications

Fibre Channel switch
module specifications:

v Fibre Channel protocols:

FC-PH version 4.3,
FC-PH-2, FC-PH-3, FC-AL
version 4.5, FC-AL-2 Rev
7.0, FC-FLA, FC-GS-3,
FC-FG, FC-PLDA,
FC-Tape, FC-VI, FC-SW-2,
Fibre Channel Element
MIB RFC 2837, and Fibre
Alliance MIB version 4.0.

v Fibre Channel service
classes: Class 2 and class
3

v Operation modes: Fibre
Channel class 2 and class
3, connectionless.

v External port type:
Generic loop port
(GL_port)

v Internal port type: fabric
port (F_port)

v Port characteristics:
External ports are
automatically detected
and self configuring

v Number of Fibre Channel
ports: 2 external ports
and 14 internal ports

v Scalability: 239 switches
maximum depending on
your configuration

v Maximum number of user
ports: 475 000 ports
depending on your
configuration

v Buffer credits: 12 buffer
credits per port

v Media type: Small
form-factor pluggable
(SFP) module

v Fabric port speed: 1.0625
or 2.125 Gbps (gigabits
per second)

v Maximum frame size:
2148 bytes (2112 byte
payload)

v System processor: Geode
SC1200

v Fabric latency: Less than
0.5 µsec

v Fabric point-to-point
bandwidth: 2 Gbps or 4
Gbps at full duplex

v Fabric aggregate
bandwidth: 64 Gbps at
full duplex

v Nonblocking architecture
to prevent latency

Switch maintainability:

v Diagnosis: Power-on
self-test (POST) is
performed on all
functional components
except the SFP module.
Port operational tests
include internal, external,
and online tests.

v User interface: LED
indicators

Fabric management:

v Management methods:

– BladeCenter SAN
Utility application

– Telnet and command
line interface (CLI)

v Switch SNMP agent:
Enables a network
management workstation
to receive configuration
values, traffic information,
and Fibre Channel failure
data through SNMP and
the Ethernet interface.

Dimensions:

v Width: 112 mm (4.41 in.)

v Height: 29 mm (1.14 in.)

v Depth: 260.3 mm (10.25
in.)

v Weight: 2 lb

Environmental:

v Temperature and altitude:

– Operating:
5°C to 40°C
(41°F to 104°F) at an
altitude of 0 to 3048 m
(0 to 10 000 ft.)

– Non-operating:
-40°C to 65°C
(-40°F to 149°F) at an
altitude of 0 to 15
240 m (0 to 50 000 ft.)
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Table 1. Fibre Channel switch module specifications (continued)

v Humidity:

– Operating: 25% to 80%,
noncondensing

– Non-operating: 25% to
90%, noncondensing

Switch regulatory
certifications:

Electrical:

v Power source loading:
3.75 amps maximum at 12
V dc

v Heat output: 45 watts
maximum

v Operating voltage:
12 V dc

v Circuit protection:
Internally fused

v Safety standards:

– UL 1950 (USA)

– UL 1950 (Canada)

– EN60950 (EC)

– Support for Japan

– Support for Korea

– CB scheme - IEC 60950

v Emissions standards: FCC
part 15B Class A (USA)

– VCCI Class A ITE
(Japan)

– ICES-003 issue 3
(Canada)

– A4EN55022 level A
(EC)

– Voltage fluctuations:
EN 61000-3-3

– Harmonics: EN
61000-3-2

– Immunity: EN55024:
1998

– Marking:

- Fcc part 15

- UL (United States)

- cUL (Canada)

- TUV

- VCCI

- CE

Shortwave laser SFP module
at 1 Gbps and multi-mode
SFP module at 2 Gbps:

v Connector: LC-LC

v Color coding: Beige or
black exposed connector
surfaces

v Cable: Fibre Channel
100-M6-SN-I (50 µm
multimode)

v Wavelength: 830 to 860
nm

v Transmit power: -10 dBm
minimum

v Receiver sensitivity: -16
dBm average

v Distance:

– 500 meters maximum
using 50 micron fiber

– 300 meters maximum
using 62.5 micron fiber

v Safety: DHHS 21 CFR(J),
IEC 825-1 CENCELEC EN
60825-1, VDE

Longwave laser SFP module
at 1 Gbps and 2 Gbps
single-mode:

v Connector: LC-LC Fibre
Channel cable

v Color coding: Blue
exposed connector
surfaces

v Cable: Fibre Channel
100SM-LC-L (9 µm single
mode)

v Wavelength:
1270 through 13.5 nm

v Transmit power: -10 dBm
minimum

v Receiver sensitivity: -20
dBm average

v Distance: 2 meters to 10
kilometers

v Safety: DHHS 21 CFR(J),
IEDC 825-1 CENELEC EN
60825-1, VDE

Related publications

This Installation Guide contains setup and installation instructions for your
switch module. This publication also provides general information about your
switch module, including getting started, how to configure your switch
module, and how to access and use online help.
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In addition to this Installation Guide, the following related documentation is
provided with your switch module:

v IBM Eserver BladeCenter Fibre Channel Switch Management User’s Guide

This publication is provided in Portable Document Format (PDF) on the IBM
BladeCenter Documentation CD. It describes how to use the SAN Utility
application. In addition, it describes how to start the Telnet CLI and lists the
CLI commands and their usage.

v IBM Eserver BladeCenter Type 8677 Installation and User’s Guide

This publication is provided in PDF on the IBM BladeCenter Documentation
CD. It provides general information about your BladeCenter unit, including:

– Information about features

– How to set up, cable, and start your BladeCenter™ unit

– How to install options in your BladeCenter unit

– How to configure your BladeCenter unit

– How to perform basic troubleshooting of your BladeCenter unit

– How to get help

v IBM Eserver BladeCenter HS20 Type 8678 Installation and User’s Guide

This publication is provided in PDF on the IBM BladeCenter Documentation
CD. It contains general information about your blade server, including:

– Information about features

– How to set up and start your blade server

– How to install options in your blade server

– How to configure your blade server

– How to install an operating system on your blade server

– How to perform basic troubleshooting of your blade server

– How to get help

v IBM Eserver HS20 Fibre Channel Expansion Card Installation and User’s Guide

This Installation and User’s Guide contains instructions for installing the
IBM HS20 Fibre Channel Expansion Card in an IBM BladeCenter HS20 blade
server. This publication contains information about:

– Installing and configuring the HS20 expansion card

– Updating the BIOS and device drivers of the HS20 expansion card

v IBM Eserver BladeCenter SAN Solutions Guide

This publication is provided in PDF on the IBM BladeCenter Documentation
CD. It provides a user-oriented discussion of how BladeCenter Fibre
Channel options are used to provide different SAN storage solutions for
various application requirements. This document also provides an overview
and description for backup and restore, business continuance and high
availability, and storage consolidation and data sharing solutions.
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v IBM Eserver BladeCenter Fibre Channel Switch Interoperability Guide

This publication is provided in PDF on the IBM BladeCenter Documentation
CD. It provides detailed Fibre Channel switch configuration data and
step-by-step configuration procedures for integrating the BladeCenter unit
into other vendor switch fabrics. Each vendor configuration includes an
initial integration checklist, configuration limitations, supported switch and
firmware versions, specific management application operations, and a
successful-integration checklist.

v Rack Installation Instructions

This publication contains the instructions to install your BladeCenter unit in
a rack.

v Safety Information

This multilingual publication is provided in PDF on the IBM BladeCenter
Documentation CD. It contains translated versions of the caution and danger
statements that appear in the documentation. Each caution and danger
statement has an assigned number, which you can use to locate the
corresponding statement in your native language.

v IBM Hardware Maintenance Manual and Troubleshooting Guide

This publication is provided in PDF on the IBM BladeCenter Documentation
CD. It contains information to help you solve the problem yourself or to
provide helpful information to a service technician.

v IBM Configuration Options Guide

This publication contains information about which small form-factor
pluggable (SFP) module and cable is required to connect your switch
module to other storage devices. This publication is at
http://www.ibm.com/eserver/bladecenter/ on the World Wide Web.

Depending on your blade server model, additional publications might be
included on the IBM BladeCenter Documentation CD.

In addition to reviewing the publications in this library, be sure to review the
IBM Eserver BladeCenter Planning and Installation Guide at
http://www.ibm.com/eserver/bladecenter/ on the World Wide Web for
information to help you prepare for system installation and configuration.

Notices and statements used in this book

The caution and danger statements that appear in this book are also in the
multilingual Safety Information book, which is on the IBM BladeCenter
Documentation CD. Each statement is numbered for reference to the
corresponding statement in the Safety Information book.

The following types of notices and statements are used in this book:

v Notes: These notices provide important tips, guidance, or advice.
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v Important: These notices provide information or advice that might help you
avoid inconvenient or problem situations.

v Attention: These notices indicate possible damage to programs, devices, or
data. An attention notice is placed just before the instruction or situation in
which damage could occur.

v Caution: These statements indicate situations that can be potentially
hazardous to you. A caution statement is placed just before the description
of a potentially hazardous procedure step or situation.

v Danger: These statements indicate situations that can be potentially lethal or
extremely hazardous to you. A danger statement is placed just before the
description of a potentially lethal or extremely hazardous procedure step or
situation.

Major components of the switch module

The orange color on components and labels on your switch module and
BladeCenter unit identifies hot-swap or hot-plug components. You can install
or remove these components while the BladeCenter unit is running, provided
that it is configured to support this function.

The blue color on components and labels indicates touch points where a
component can be gripped, a latch moved, and so on.

Figure 1 shows the major components of your switch module.

Note: The illustrations in this document might differ slightly from your
hardware.

Release
latch

Release
lever

Information panel

Fibre channel switch module

Media access control
(MAC) address labelProduct name

and media access
control (MAC)
address label

Figure 1. Fibre Channel switch module major components
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For more information about the components of the information panel, see
Chapter 3, “Information panel LEDs and external Fibre Channel ports”, on
page 21. For more information about the MAC address, see the IBM Eserver

BladeCenter Fibre Channel Switch Management User’s Guide provided on the IBM
BladeCenter Documentation CD.
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Chapter 2. Installing and replacing a switch module

Figure 2 shows the switch-module bay locations in the BladeCenter unit.

You must install switch modules only in switch-module bays 3 and 4 of the
IBM Eserver BladeCenter Type 8677. At least one switch module is required
when you install the IBM HS20 Fibre Channel Expansion Card in the blade
server. Installing a switch module in bay 3 or bay 4 provides the first
connection to any installed HS20 Fibre Channel expansion card in the
BladeCenter unit. Installing a second switch module enables a second
connection to an HS20 Fibre Channel expansion card in the BladeCenter unit.
Adding a second switch module provides a redundant path and a separate
Fibre Channel connection from the blade server to the external Fibre Channel
network and SAN.

Important: The switch modules in switch-module bays 3 and 4 and all blade
server expansion cards in the BladeCenter unit must use the same interface
type. Therefore, you must install Fibre Channel expansion cards when you
install Fibre Channel switch modules into your BladeCenter unit.

AC

AC

DC

DC

Fibre Channel
switch module
bay 3

Fibre Channel
switch module
bay 4

BladeCenter unit
rear view

Figure 2. BladeCenter unit rear view
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The following table summarizes the application for each switch module.

Bay Fibre Channel switch module function

3 Port 1 connection to the blade server interface expansion card in the
BladeCenter unit

4 Port 2 connection to the blade server interface expansion card in the
BladeCenter unit

Note: The second switch module port connection allows for a redundant path
from the blade server to external Fibre Channel devices.

Installation guidelines

Before you begin to install the switch module in your BladeCenter unit, read
the following information:

v Become familiar with the safety and handling guidelines specified under
“Safety” on page v and “Handling static-sensitive devices” on page 13, and
read the safety statements in BladeCenter unit option publications.

v The orange color on components and labels in your BladeCenter unit
identifies hot-swap or hot-plug components. You can install or remove
hot-swap modules while the BladeCenter unit is running. For complete
details about installing or removing a hot-swap or hot-plug component, see
the detailed information in this chapter.

v The blue color on components and labels identifies touch points where you
can grip a component, move a latch, and so on.

v You do not need to turn off the BladeCenter unit to install or replace any of
the hot-swap modules on the rear of the BladeCenter unit.

v For a list of supported options for your BladeCenter unit, go to
http://www.ibm.com/pc/us/compat/ on the World Wide Web.
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System reliability considerations

Attention: To help ensure proper cooling and system reliability, make sure
that:

v Each of the module bays on the rear of the BladeCenter unit has either a
module or filler module installed.

v A removed hot-swap module is replaced with an identical module or filler
module within 1 minute of removal.

v A removed hot-swap blade server is replaced with an identical blade server
or a filler blade within 1 minute of removal.

Cable requirements for the switch module are described in the IBM
Configuration Options Guide at http://www.ibm.com/eserver/bladecenter/ on
the World Wide Web. See the documentation that comes with your blade
server for cable routing information.

Handling static-sensitive devices

Attention: Static electricity can damage electronic devices and your system.
To avoid damage, keep static-sensitive devices in their static-protective
packages until you are ready to install them.

To reduce the possibility of electrostatic discharge, observe the following
precautions:

v Limit your movement. Movement can cause static electricity to build up
around you.

v Handle the device carefully, holding it by its edges or its frame.

v Do not touch solder joints, pins, or exposed printed circuitry.

v Do not leave the device where others can handle and damage it.

v While the device is still in its static-protective package, touch it to an
unpainted metal part of the BladeCenter unit for at least 2 seconds. This
drains static electricity from the package and from your body.

v Remove the device from its package and install it directly into the
BladeCenter unit without setting down the device. If it is necessary to set
down the device, put it back in its static-protective package. Do not place
the device on your system unit cover or on a metal surface.

v Take additional care when handling devices during cold weather. Heating
reduces indoor humidity and increases static electricity.
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Installing a switch module

Statement 3:

CAUTION:
When laser products (such as CD-ROMs, DVD drives, fiber optic devices, or
transmitters) are installed, note the following:

v Do not remove the covers. Removing the covers of the laser product could
result in exposure to hazardous laser radiation. There are no serviceable
parts inside the device.

v Use of controls or adjustments or performance of procedures other than
those specified herein might result in hazardous radiation exposure.

DANGER

Some laser products contain an embedded Class 3A or Class 3B laser
diode. Note the following.

Laser radiation when open. Do not stare into the beam, do not view
directly with optical instruments, and avoid direct exposure to the beam.

Class 1 Laser Product
Laser Klasse 1
Laser Klass 1
Luokan 1 Laserlaite
Appareil A Laser de Classe 1`
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Statement 8:

CAUTION:
Never remove the cover on a power supply or any part that has the
following label attached.

Hazardous voltage, current, and energy levels are present inside any
component that has this label attached. There are no serviceable parts inside
these components. If you suspect a problem with one of these parts, contact
a service technician.

Complete the following steps to install a switch module:

1. Review the information in “Safety” on page v and “Installation guidelines”
on page 12 through “Handling static-sensitive devices” on page 13.

2. Remove the acoustic attenuation module option, if necessary, from the rear
of the BladeCenter unit. See the IBM ERserver BladeCenter type 8677
Installation and User’s Guide for detailed removal instructions.
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3. Be sure that the BladeCenter unit is turned on, the green dc power LED
on each power module is lit, and the green OK LED on the management
module is lit.

4. Select only switch-module bay 3 or bay 4 in which to install the switch
module.

5. Remove the filler module from the switch-module bay in which you are
installing the switch module. Store the filler module for future use.

Note: Install your switch module only in switch-module bay 3 or bay 4.

6. If you have not already done so, touch the static-protective package that
contains the switch module to an unpainted metal part of the BladeCenter
unit for at least 2 seconds.

7. Remove the switch module from its static-protective package.

8. Ensure that the release lever and latch on the switch module is in the
open position (perpendicular to the module).

Figure 4 on page 17 shows how to install a switch module in the rear of
the BladeCenter unit.

Acoustic
attenuation
module

Locking
handle

Figure 3. Removing the acoustic attenuation module
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9. Slide the switch module into the switch-module bay until it stops.

10. Push the release lever and latch on the front of the switch module to the
closed position.

Note: The switch module takes approximately 85 seconds to complete the
POST. When the switch module is powered on, a LED test occurs.
All LEDs are lit and remain lit for approximately 10 to 15 seconds
and then return to normal state.

11. Make sure that the LEDs on the switch module indicate that it is operating
properly. Verify that:

v When the POST starts, the OK LED on the switch module will be off.
The POST tests the condition of firmware, memories, data paths, and
switch logic and uses the heartbeat LED to indicate pass or fail
conditions.

v The green OK LED on the switch module is lit to indicate that the
switch logic has completed POST.

v The green heartbeat LED on the switch module has a steady flash rate
of once per second. This indicates that the switch module is operating
with no errors.

Note: If the heartbeat LED is not flashing once per second, the POST has
failed. Be sure the BladeCenter unit is powered on and the

BladeCenter
unit

LatchRelease
lever

Fibre Channel
switch module

Figure 4. Installing a switch module
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BladeCenter LEDs are lit. If POST has failed, see the IBM Eserver

BladeCenter Fibre Channel Switch Management User’s Guide for
diagnostic information.

12. If you have a second switch module to install, repeat step 5 on page 16
through step 11 on page 17; otherwise, go to step 13.

13. If needed, connect an SFP module option into external Fibre Channel port
1 and Fibre Channel port 2. For SFP module installation instructions, see
the documentation that comes with your SFP module.

Note: SFP module options do not come with the switch module but are
required to use external switch module ports.

14. Use LC-LC fiber-optic cables to connect the switch module external ports
to external Fibre Channel devices. For more information, see the
documentation that comes with your cable options.

Note: You can remove and replace an SFP module while the switch
module is operating without damaging the switch module or the
SFP module. However, transmission on the affected port will be
interrupted until the SFP module and cables are installed. See the
documentation that comes with your connected Fibre Channel
device for information about installation, configuration, and startup
sequence.

15. Replace the acoustic attenuation module, if you removed it in step 2 on
page 15.

16. Continue with Chapter 3, “Information panel LEDs and external Fibre
Channel ports”, on page 21.

18 IBM Eserver BladeCenter 2-Port Fibre Channel Switch Module: Installation Guide



Removing or replacing a switch module

Statement 8:

CAUTION:
Never remove the cover on a power supply or any part that has the
following label attached.

Hazardous voltage, current, and energy levels are present inside any
component that has this label attached. There are no serviceable parts inside
these components. If you suspect a problem with one of these parts, contact
a service technician.

Complete the following steps to replace a switch module:

1. Review the information in “Safety” on page v and “Installation guidelines”
on page 12 through “Handling static-sensitive devices” on page 13.

2. Remove the acoustic attenuation module, if any, from the rear of the
BladeCenter unit. For more information, see the illustration in step 2 on
page 15 and the IBM ERserver BladeCenter type 8677 Installation and User’s
Guide.

3. Remove the LC-LC fiber-optic cables from the two external ports on the
SFP module. Removing these cables will disrupt the network connection
from the external Fibre Channel port to any connected external Fibre
Channel devices. For removal instructions, see the documentation that
comes with your cable options.

4. Remove any SFP modules from the switch module external Fibre Channel
ports. For SFP module removal instructions, see the documentation that
comes with your SFP module.

5. Pull the release latch toward the bottom of the switch module, as shown in
Figure 5 on page 20. The module moves out of the bay approximately 0.64
cm (0.25 inch).
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Attention: If you do not replace the switch module, you must insert a
filler module into the empty bay within 1 minute.

6. Slide the switch module out of the bay and set it aside. Within 1 minute,
place either another switch module or a filler module in the bay.

Note: To verify that the switch module is active after you replace it, see
step 10 and step 11 on page 17.

7. If you placed another switch module into the bay, if needed, insert any SFP
modules that you removed in step 4 into external Fibre Channel port 1 and
Fibre Channel port 2. For SFP module installation instructions, see the
documentation that comes with your SFP module.

8. If needed, use LC-LC fiber-optic cables to connect the switch module
external port to external Fibre Channel devices. For more information, see
the documentation that comes with your cable options.

9. Replace the acoustic attenuation module option, if you removed it in step 2.
For detailed installation instructions, see the IBM ERserver BladeCenter type
8677 Installation and User’s Guide.

Figure 5. Fibre Channel switch module release latch
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Chapter 3. Information panel LEDs and external Fibre
Channel ports

This chapter describes the information panel and LEDs on the switch module.
This chapter also identifies the external Fibre Channel ports on the information
panel.

Information panel

The switch module information panel contains LEDs and two Fibre Channel
ports, as shown in Figure 6.

The switch module information panel contains:

v Comprehensive LEDs that display the status of the switch module and the
network. For more information, see “LEDs” on page 22.

v Two external Fibre Channel ports to connect Fibre Channel devices, end
devices, and servers. These ports are identified as port 2 and port 1 in the
switch configuration menus and are labeled 2 and 1 (from top to bottom) on
the switch module, as shown in the Figure 6.

OK

LOG

2

1

FC

TX
RX

Port LEDs

External Fibre Channel
port 2

Fibre Channel
switch module
LEDs

External Fibre Channel
port 1

Figure 6. Fibre Channel switch module information panel

© Copyright IBM Corp. 2003 21



LEDs

There are three sets of LEDs on the information panel. The first row of LEDs at
the top of the switch module represent switch module status and include OK,
♥ (heartbeat), and ! (Fibre Channel switch fault). The second and third sets of
LEDs represent status for external Fibre Channel port 2 and external Fibre
Channel port 1. The port LEDs include port logged-in, port activity, and port
fault. Figure 7 shows the locations of these LEDs on the switch module. In
addition, this section provides a description of each LED and their and
diagnostic flash patterns. See the IBM Eserver BladeCenter Fibre Channel Switch
Management User’s Guide for more information about diagnostic flash patterns.

Notes:

1. The illustrations in this document might differ slightly from your hardware.

2. An amber LED is lit when a system error or event has occurred. To identify
the error or event, check the LEDs on the information panel of the switch
module and see Table 2 on page 23 for more information.

OK

LOG

2

1

FC

TX
RX

Power-on LED
(green)

Heartbeat LED
(green)

Switch fault LED
(amber)

Port 2 fault LED
(amber)

Port 1 fault LED
(amber)

Port 2 activity LED
(green)

Port 1 activity LED
(green)

Port 2 logged
in LED
(green)

Port 1 logged
in LED
(green)

Fibre Channel
port 2

Fibre Channel
port 1

Figure 7. Fibre Channel switch module LEDs
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3. An LED test occurs whenever the switch module is turned on. All LEDs are
lit and remain lit for approximately 10 to 15 seconds and then return to a
normal state.

OK: This green LED is at the top of the switch module on the information
panel. When this LED is lit, it indicates that the switch module has passed the
POST and is operational.

♥ (heartbeat): This green LED is at the top of the switch module on the
information panel. When this LED is flashing, it indicates the status of the
internal switch module processor and the results of the POST.

Note: One flash per second indicates that the switch module processor is
operating in OK status. Other flash patterns indicate POST errors. For
more information, see Table 2.

! (Fibre Channel switch fault): This amber LED is at the top of the switch
module on the information panel. This LED indicates that the switch module
has a fault. If the switch module fails the POST, this fault LED is lit.

Port logged-in: There are two green port logged-in LEDs. The port 2 logged-in
LED is at the top of port 2, and the port 1 logged-in LED is at the bottom of
port 1. When one of these LEDs is lit, it indicates that there is a connection (or
link) to a device on that port.

Port activity: There are two green port activity LEDs. The port 2 activity LED
is at the top of port 2, and the port 1 activity LED is at the bottom of port 1.
When one of these LEDs flashes, it indicates that data is being received or
transmitted (that is, activity is occurring) on that port. The flash frequency is
proportional to the amount of traffic on that port.

Port fault: There are two amber port fault LEDs. The port 2 fault LED is at the
top of port 2, and the port 1 fault LED is at the bottom of port 1. When a port
fault LED is lit, it indicates that the external port has failed the internal,
external, or online port diagnostics tests that are performed with the SAN
Utility or CLI. For more information, see the diagnostic section of the IBM
Eserver BladeCenter Fibre Channel Switch Management User’s Guide.

Table 2. Switch module LED diagnostic flash patterns

LED LED activity

OK
v The LED is off during initialization and POST or when there is a

system fault.

v The LED is lit during LED test and when the switch module is
operational.

v The LED does not flash.
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Table 2. Switch module LED diagnostic flash patterns (continued)

LED LED activity

Heartbeat
v The LED is off when you reset the blade server and when the Fibre

Channel switch module processor is not operational.

v The LED is lit steady on only during LED test.

v The LED flashes to indicate the following conditions:

– Normal operation - The LED flashes at a steady rate of one flash
per second.

– Internal firmware failure - The LED flashes two times, at twice
the normal rate, followed by a 2-second pause.

– Fatal error - The LED flashes three times, at twice the normal
rate, followed by a 2-second pause.

– Configuration file system error - The LED flashes four times, at
twice the normal rate, followed by a 2-second pause.
Note: See the diagnostic section of the IBM Eserver BladeCenter
Fibre Channel Switch Management User’s Guide for more
information about diagnostic flash patterns.

Switch fault
v The LED is off during initialization or when the switch module is

in normal operation.

v The LED is lit during LED test or to indicate a system fault during
a POST failure or thermal fault.

v The LED does not flash.

Port logged-in
v The LED is off when the port is not logged in.

v The LED is lit when the port is logged-in or during LED test.

v The LED pattern indicates the following conditions:

– Logged in - The LED is lit.

– Logging in - The LED flashes at 1-second intervals.

– Beacon location - The LED flashes at 1-second intervals. For
more information, see the IBM Eserver BladeCenter Fibre Channel
Switch Management User’s Guide.

– Error - The LED flashes two times per second.

Port activity
v The LED is off when the port is not logged in or when the port is

logged in and there is no port activity.

v The LED is lit during LED test.

v The LED flashes when port activity performs a normal send or
receive operation.

Port fault
v The LED is off when port diagnostics starts and is completed

without error.

v The LED is lit when port diagnostics discovers a port error.

v The LED does not flash.
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Chapter 4. Configuring the switch module through the
Telnet interface

Your switch module contains a Telnet server. This server enables a Telnet client
to establish a Telnet session with the Fibre Channel switch module to retrieve
information or to configure parameters using the CLI. You can perform a
variety of fabric and switch management tasks through an Ethernet connection
using the CLI.

You can access the Telnet interface in two ways:

v In the BladeCenter management module Web interface

v In a command line window on a network management workstation

To configure the switch module through the Telnet interface, the IP address
and subnet masks must be compatible. In addition to the IP addressing, to
access a switch module from a network management workstation that is
connected to an external Ethernet port, the following configuration settings in
the management module must be enabled:

v Switch module external port 1 and port 2

v External management for external port 1 and port 2

To enable the configuration settings, in the management module Web interface,
click Switch Tasks → Management → Advanced Switch Management →
Advanced Setup.

Important: Before you configure your switch module, be sure that the
management modules in your BladeCenter unit are properly configured. In
addition, to access and manage your switch module from an external
environment, you might need to enable certain features, such as the external
ports and external management over all ports. See the applicable BladeCenter
Installation and User’s Guide publications on the IBM BladeCenter Documentation
CD for more information. For more detailed information about configuring
your switch module, see the IBM Eserver BladeCenter Fibre Channel Switch
Management User’s Guide on the IBM BladeCenter Documentation CD.

In addition to reviewing the publications in this library, be sure to review the
IBM Eserver BladeCenter Planning and Installation Guide at
http://www.ibm.com/eserver/bladecenter/ on the World Wide Web for
information to help you prepare for system installation and configuration.
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Connecting to the switch module

To use the Telnet program (in VT100 compatible terminal mode) to access and
control the switch module, you must know the IP address for your switch
module and have an existing network connection. If you need to obtain the IP
address for your switch module or establish a network connection, contact
your system or network administrator. Be sure to use the correct IP address in
the required command.

Establishing a Telnet session through the management
module

Complete the following steps to establish a Telnet session through the
BladeCenter management module:

1. In your browser, in the address bar, type http://xxx.xxx.xxx.xxx, where
xxx.xxx.xxx.xxx is the IP address of the BladeCenter management-module
interface. Click GO or press Enter. The Enter Network Password window
opens.

Note: The default IP address for the BladeCenter management module is
192.168.70.125.

2. In the User Name field, type the initial default user ID, USERID. In the
Password field, type the initial default password, PASSW0RD (the sixth

Figure 8. Enter Network Password window
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character is a zero, not the letter O). The user ID and password are case
sensitive. The Active Session from Same Client window opens.

3. In the Inactive session timeout value field, select the timeout value for
this Web session and click Start New Session. The BladeCenter
management module main window opens.

Figure 9. Active Session from Same Client window
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4. In the left navigation pane under Switch Tasks, click Management. The
Switch Management window opens.

Figure 10. Management Module window
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5. Click the link for either Switch Module 3 or Switch Module 4. A window
similar to the one in Figure 12 on page 30 opens.

Figure 11. Switch Management window
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6. Verify that the IP address is the same in the Current IP Configuration and
New Static IP Configuration sections.

7. Scroll down and click Advanced Switch Management. A window similar
to the one in Figure 13 on page 31 opens.

Figure 12. Switch Management window showing switch module 3 example
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8. To start a Telnet session, scroll down to the Start Telnet/Web Session
section and click Start Telnet Session.

9. The switch module Telnet Login window opens, as shown in Figure 14.

Figure 13. Switch Management window - advanced

Figure 14. Fibre Channel Switch Module Telnet Login window
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10. At the Login prompt, type the initial default user ID, USERID and press
Enter. At the Password prompt, type the initial default password,
PASSW0RD (the sixth character is a zero, not the letter O). The user ID and
password are case sensitive.

11. Click OK to open the Command Line Interface Shell window.

To open online help, type help and press Enter.

Continue with “CLI command format” on page 34. For more information about
using the CLI, see the IBM Eserver BladeCenter Fibre Channel Switch
Management User’s Guide.

Establishing a Telnet session in a command-line window

Note: The switch module can be accessed by IP-enabled devices that are
connected to BladeCenter Ethernet switch modules. An Ethernet
connection to the management module external ports on the
BladeCenter unit is required. See the IBM Eserver BladeCenter Type 8677
Installation and User’s Guide for more information.

Complete the following steps to establish a Telnet session through a
command-line window:

1. Open a command-line window on the network management workstation
and type one of the following commands and press Enter. Note that the
following are default IP addresses.

Figure 15. Command Line Interface Shell window
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For switch module bay 3:
telnet 192.168.70.129

For switch module bay 4:
telnet 192.168.70.130

A Command Prompt window opens.

2. At the Login prompt, type the initial default user ID, USERID and press
Enter. At the Password prompt, type the initial default password, PASSW0RD
(the sixth character is a zero, not the letter O). The user ID and password
are case sensitive.

The Command Line Interface Shell window opens.

Figure 16. Command Prompt window
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Continue with “CLI command format”.

CLI command format

The information in this section gives an overview of the CLI command format.

For detailed information about using CLI commands, see the IBM Eserver

BladeCenter Fibre Channel Switch Management User’s Guide on the IBM
BladeCenter Documentation CD.

A command is followed by one or more keywords. Consider the following
rules when typing keywords:

v Commands and keywords are lowercase and case sensitive.

v Required keyword values are shown in standard font: [value}. Optional
values are shown in italics [value].

v The underlined portion of each keyword indicates the abbreviated form that
can be used. For example, the Delete keyword can be abbreviated as Del.

The CLI command syntax is as follows:

v keyword

v keyword [value]

v keyword [value][value 2]

Items in square brackets ([ ]) can be changed by typing a new value. You can
use the Backspace and Delete keys to erase characters behind and in front of
the cursor.

Figure 17. Command Line Interface Shell window
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Chapter 5. Installing the IBM BladeCenter SAN Utility

You can use the BladeCenter SAN Utility application to access and configure
the switch modules. The SAN Utility can be installed on a network
management workstation, which is either a BladeCenter blade server or an
external network management workstation configured with one of the
operating systems described in “System requirements”.

This chapter lists system requirements and explains how to install the SAN
Utility. In addition, this chapter describes two basic windows you will use to
manage your fabrics and switch modules: Topology and Faceplate.

Important: Before you configure your switch module, be sure that the
management modules in your BladeCenter unit are properly configured. In
addition, to access and manage your switch module from an external
environment, you might need to enable certain features, such as the external
ports and external management over all ports. See the applicable BladeCenter
Unit Installation and User’s Guide publications on the IBM Eserver BladeCenter
Documentation CD for more information. For more detailed information about
configuring and managing your switch module, see the IBM Eserver

BladeCenter Fibre Channel Switch Management User’s Guide on the IBM
BladeCenter Documentation CD.

In addition to reviewing the publications in this library, be sure to review the
IBM Eserver BladeCenter Planning and Installation Guide at
http://www.ibm.com/eserver/bladecenter/ on the World Wide Web for
information to help you prepare for system installation and configuration.

System requirements

Before you install the SAN Utility, be sure that your network management
workstation has the following hardware and software.

Table 3. Network management workstation requirements

Operating system
v Microsoft® Windows® 2000 Integrated with Service Pack 3

v Red Hat Linux® Advanced Server Version 2.1

v Red Hat Linux Version 7.x

v SuSE Linux Professional Version 8.0

Memory 128 MB minimum

Disk space 150 MB for each installation

Processor 300 MHz or faster

Hardware CD-ROM drive, 10/100/1000 Base-T Ethernet port
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Table 3. Network management workstation requirements (continued)

Internet browser Microsoft Internet Explorer or Netscape Navigator

Use the applicable procedure in the following sections to install the SAN
Utility on your network management workstation.

Installing the SAN Utility on a Microsoft Windows 2000
platform

Complete the following steps to install the SAN Utility on a network
management workstation that is configured with Microsoft Windows 2000:

1. If your network management workstation is a BladeCenter blade server, to
associate the CD-ROM drive with the blade server, press the
CD/diskette/USB select button on the blade server. For the location of the
CD/diskette/USB button, see the documentation that comes with the blade
server. The LED on the button flashes while the request is being processed,
then is steady when the ownership of the CD-ROM drive is transferred to
the blade server.

2. If your network management workstation is a BladeCenter blade server, to
associate the keyboard port, mouse port, and video port with the blade
server, press the keyboard/mouse/video select button. The LED on this
button flashes while the request is processed, then is steady when the
ownership of the keyboard, mouse and video is transferred to the blade
server.

3. Close all open programs. Insert the IBM BladeCenter SAN Utility CD into
the CD-ROM drive.

4. Open Windows Explorer and double-click the CD-ROM drive letter.

5. To install the SAN Utility, use one of the following methods, where x.xx.xx
is the SAN Utility version number:

v To install from the CD, mount the CD and double-click
Windowsx.xx.xx.exe. Follow the SAN Utility installation instructions.

v To copy and install from the hard disk drive, complete the following
steps:

a. Specify a location and save the Windowsx.xx.xx.exe file.

b. Click Save.

c. Double-click Windowsx.xx.xx.exe.

d. Follow the SAN Utility installation instructions.

6. When the installation is completed, use one of the following methods to
start the SAN Utility:

v Double-click the BladeCenter SAN Utility shortcut.
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v Click Start → Programs → BladeCenterSANUtility →
BladeCenterSANUtility.

If a default fabric view file exists, the Enter Default File Password for
Loading File window opens, as shown in Figure 18. Otherwise, the SAN
Utility window opens.

Continue with “Using the SAN Utility” on page 39.

Uninstalling the SAN Utility on a Microsoft Windows 2000
platform

The Uninstaller Data folder is copied into the installation folder during the
initial SAN Utility installation process. The Uninstaller Data folder contains the
Uninstall BladeCenter SAN Utility program that is used to uninstall the SAN
Utility from a network management workstation running Microsoft Windows
2000. In addition, a shortcut to the uninstall program is installed in the user’s
home directory during the SAN Utility installation process. The default
installation directory is C:/Program files/BladeCenterSANUtility.

Complete the following steps to uninstall the SAN Utility:

1. Browse for the uninstallation program file or the shortcut that points to the
uninstallation program.

Locate the uninstallation program shortcut in the same folder as the
program shortcut or click Start → Programs → BladeCenterSANUtility →
Uninstall BladeCenterSANUtility.

2. Double-click the uninstallation program or shortcut and follow the
instructions to uninstall the SAN Utility.

Figure 18. Enter Default File Password For Loading file window
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Installing the SAN Utility on a Red Hat Linux or SuSE Linux
Professional platform

Complete the following steps to install the SAN Utility on a network
management workstation that is configured with Red Hat Linux or SuSE Linux
Professional:

1. If your network management workstation is a BladeCenter blade server, to
associate the CD-ROM drive with the blade server, press the
CD/diskette/USB select button on the blade server. For the location of the
CD/diskette/USB button, see the documentation that comes with the blade
server. The LED on the button flashes while the request is being processed,
then is steady when the ownership of the CD-ROM drive is transferred to
the blade server.

2. If your network management workstation is a BladeCenter blade server, to
associate the keyboard port, mouse port, and video port with the blade
server, press the keyboard/mouse/video select button. The LED on this
button flashes while the request is processed, then is steady when the
ownership of the keyboard, mouse and video is transferred to the blade
server.

3. Close all open programs. Insert the IBM BladeCenter SAN Utility CD into
the CD-ROM drive.

4. Open an xterm or other terminal window.

5. Mount the CD. From a shell command-line prompt, type the following
command and press Enter:
mount /mnt/cdrom

6. To install the SAN Utility, use one of the following methods, where x.xx.xx
is the SAN Utility version number:

v To install from the CD, type:
sh /mnt/cdrom/Linux/Linux_x.xx.xx.bin

Follow the SAN Utility installation instructions.

v To copy and install from your hard disk drive, complete the following
steps:

a. Type:
cp /mnt/cdrom/Linux/Linux_x.xx.xx.bin /[directory]/

Where[directory] is where you want to copy the files to.

b. Open a terminal window for the directory in which the
Linux_x.xx.xx.bin file was saved.

c. Type:
sh Linux_x.xx.xx.bin

d. Follow the SAN Utility installation instructions.
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7. To start the SAN Utility after the installation is completed, from a
command prompt, type one the following commands and press Enter:
sh /opt/BladecenterSANUtility/BladeCenterSANUtility

sh /opt/runBladeCenterSANUtility

If a default fabric view file exists, the “Enter Default File Password for
Loading File” window opens, as shown in Figure 18 on page 37. Otherwise,
the SAN Utility window opens.

Go to “Using the SAN Utility”.

Uninstalling the SAN Utility on a Red Hat Linux or SuSE
Linux Professional platform

The Uninstaller Data folder is copied into the installation folder during the
initial SAN Utility installation process. The Uninstaller Data folder contains the
Uninstall BladeCenter SAN Utility program that is used to uninstall the SAN
Utility from a network management workstation running Red Hat Linux or
SuSE Linux Professional. In addition, a shortcut to the uninstallation program
is installed in the user’s home directory during the SAN Utility installation
process. The default installation directory is /opt/BladeCenterSANUtility/.

Complete the following steps to uninstall the SAN Utility:

1. At the command prompt, type the following command and press Enter:
# cd /opt/

2. At the command prompt, type the following command and press Enter:
#sh Uninstall_IBM_BladeCenter_San_Utility

Using the SAN Utility

Use the following procedures to start the SAN Utility and complete the
following tasks:

v Start the SAN Utility and add a new fabric

v Change the password for the default fabric view

v Set user preferences

v Access online help

v Save the default fabric

v Exit the SAN Utility
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Starting the SAN Utility and adding a new fabric
When you have successfully installed the SAN Utility and the default fabric
view does not exist, the IBM BladeCenter SAN Utility - Topology window
(referred to as the Topology window) opens, as shown in Figure 19.

If the default fabric view file exists, the Enter Default File Password for
Loading File window opens, as shown in Figure 18 on page 37. Complete the
following steps to start the SAN Utility and add a new fabric:

1. At the Default file password prompt, type the password and click Load
View File.

The SAN Utility starts, and any previously saved set of fabrics is displayed.
If no set of fabrics has been saved previously, click Continue Without
Loading to open an empty fabric view.

The Topology window opens, as shown in Figure 19.

2. Click Add.

The Add a New Fabric window opens, as shown in Figure 20 on page 41.

Figure 19. Topology window
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3. In the Fabric name field, type a fabric name.

4. In the IP address field, type the IP address of the switch module.

5. In the Login name field, type the initial default user ID, USERID. In the
Password field, type the initial default password, PASSW0RD (the sixth
character is a zero, not the letter O). The user ID and password are case
sensitive.

Note: Security is disabled by default. When security is disabled, you are
not required to type a login name or password. The default
password is for the switch module and is stored in the switch
module firmware. If you want to use a Telnet command set to grant
user and authority levels, see the IBM Eserver BladeCenter Fibre
Channel Switch Management User’s Guide for more information.

6. Click Add Fabric.

See the IBM Eserver BladeCenter Fibre Channel Switch Management User’s Guide
for information about managing fabrics.

Changing the password for the default fabric view
Complete the following steps to change the password for the default fabric
view file:

Figure 20. Add a New Fabric window
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1. In the Topology window, click File → Change Default File Password.

The Set New Password window opens, as shown in Figure 21.

2. In the Default file password field, type the new password.

3. In the Re-enter password to confirm field, type the same password again.

4. Click OK to save your changes.

Note: If you lose the password for the account, contact IBM Support (see
Appendix A, “Getting help and technical assistance”, on page 49).

Setting user preferences
Use the Preferences window to perform the following tasks:

v Change the location of the working directory that you will use to save files.

v Change the location of the browser used to view the online help.

v Choose the fabric discovery interval. Rates are 30, 45, or 60 seconds. The
fabric discovery interval indicates how often the SAN Utility polls the fabric.

v Enable or disable the default view file auto save and load feature. See
“Using the SAN Utility” on page 39 for more information about the default
fabric view file.

v Select the default port view when opening the SAN Utility Faceplate
window (referred to as the Faceplate window). See the IBM Eserver

BladeCenter Fibre Channel Switch Management User’s Guide for more
information about port views.

Complete the following steps from the Faceplate window to set user
preferences for your SAN Utility sessions:

Figure 21. Set New Password window
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1. Click File → Preferences.

The Preferences window opens, as shown in Figure 22.

2. Type or browse to the paths to the working directory and browser.

3. In the Application-wide Options area of the window, complete the
following steps:

a. In the Fabric discovery interval field, select a polling frequency (30
seconds is the default value).

b. In the View file auto save and load field, select Enabled or Disabled.

c. In the Preferred initial port view field, select the port view mode for
the Faceplate window.

4. Click OK to save your changes.

Using online help
Online help is available for the SAN Utility. You can access online help using
the following two methods:

v From the BladeCenter SAN Utility window menu bar, click Help → Help
Topics.

v From the BladeCenter SAN Utility window toolbar, click Help.

To view the SAN Utility software version and copyright information, click
Help → About.

Figure 22. Preferences window
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Exiting the SAN Utility
When you exit the SAN Utility, the current fabric view is encrypted and saved
to the default fabric view file (fc_view.dft). A password is required to encrypt
and save the default fabric view file the first time you exit the SAN Utility.
When you exit subsequent sessions, the SAN Utility closes and saves the
default fabric view file automatically without requiring a password.

In your next session, the SAN Utility opens the default fabric view file
automatically after you type the password. To prevent the SAN Utility from
automatically saving the default fabric view file each time you exit a session,
select Disabled in the View file auto save and load field (it is set to Enabled
by default). See “Setting user preferences” on page 42 for more information.

Complete the following steps to exit a SAN Utility session:

1. From the Faceplate window, click File → Exit.

The Enter Default File Password for Loading File window opens, as shown
in Figure 18 on page 37.

2. When you are prompted to type a password with which to protect the
default fabric view file, complete one of the following tasks:

v To save the current set of fabrics in the default fabric view file
(fc_view.dft) in the working directory, type a password and click Save
View File.

Note: If the default fabric view file was saved with a password, the next
time you open the SAN Utility, you will be prompted for the
password in the Load Default Fabric View File window. The fabric
window opens after you type the password.

v Click Exit Without Saving to exit the program without saving the
current fabrics to the default fabric view file.

v Click Cancel Exit to cancel the exit operation.

SAN Utility Topology and Faceplate windows

The SAN Utility provides two basic windows for you to manage the fabric and
switch modules. The windows are called Topology and Faceplate. Both
windows share the following common elements:

Menu bar: The menus and the items offered in them vary depending on which
window is open. For example, the port menu and many of the switch menu
selections are displayed only in the Faceplate window. Menu items have a gray
background.

In addition to the menu bar, each window has context-sensitive menus that
open when you right-click in the graphic window. See the information about
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opening the Faceplate window and pop-up window in the IBM Eserver

BladeCenter Fibre Channel Switch Management User’s Guide.

Toolbar: The toolbar consists of a row of graphical buttons that you can use to
access SAN Utility functions. The toolbar buttons are an alternative method to
using the menu bar.

Fabric tree: The fabric tree, shown in the FC Fabrics pane, lists the managed
fabrics and their associated switches. The pane width can be adjusted by
clicking and dragging the moveable border. An entry handle to the left of an
entry in the tree indicates that the entry can be expanded. Click this handle or
double-click the entry to expand or contract a fabric tree entry. A fabric entry
expands to show its member switches.

You can use the fabric tree to access any fabric or switch using the Topology or
Faceplate window. You can click a fabric entry to open the Topology window
from the fabric tree. You can click a switch entry to open the Faceplate window
from the fabric tree.

Graphic window: The graphic window presents graphic information about
fabrics and switches such as the fabric topology and the switch faceplate. You
can adjust the window length by clicking and dragging the window border
that it shares with the data window.

Data window and tabs: A table of data and statistics associated with the
selected tab is displayed in the data window. Use the scroll bar to browse
through the data. The window length can be adjusted by clicking and dragging
the border that it shares with the graphic window. The data window tabs
present options for the type of information that is displayed in the data
window. These options vary depending on the tab you select.

Working status indicator: The working status indicator is in the lower-right
corner of the SAN Utility window. The indicator is displayed when the
network management workstation is exchanging information with the fabric.
As conditions change, the fabric forwards this information to the network
management workstation where it is displayed in the various windows.

Switch modules that are enabled and the connections between switch modules
are displayed in the Topology window, as shown in Figure 23 on page 46.
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A single switch and its active ports are displayed in the Faceplate window, as
shown in Figure 24 on page 47.

Menu bar

Toolbar

Fabric tree

Graphic window

Data window

Data window tabs Working status
indicator

Figure 23. Topology window elements
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The fabric tree, in the FC Fabrics pane, lists the managed fabrics and their
switches. You can adjust the window by clicking and dragging the moveable
window border. An entry handle at the left of the entry in the tree indicates
that the entry can be expanded. When you click the handle or double-click the
entry, the entry expands to show its member switches. These fabric tree
elements are shown in Figure 25.

Menu bar

Toolbar

Fabric tree

Graphic window

Data window

Data window tabs Working status
indicator

Figure 24. Faceplate window elements

Fabric
entry

Entry
handle

Adjustable
window
border

Switch
entry

Figure 25. Fabric tree elements
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Each fabric tree entry has a small icon next to it that uses color to indicate the
following operational status:

v A green switch entry icon indicates that the switch module is in normal
operation.

v A red switch entry icon indicates that the switch module has a
communications failure.

v A blue switch entry icon indicates that the switch status is Unknown or that
security is enabled on the switch module, but security is disabled on the
fabric management switch.

v A amber icon indicates that a switch is operational with errors.

The fabric tree provides access to the Topology and Faceplate windows for any
fabric or switch.

v To open the Topology window from the fabric tree, click a fabric entry.

v Top open the Faceplate window from the fabric tree, click a switch entry.

See the IBM Eserver BladeCenter Fibre Channel Switch Management User’s Guide
for information about using the Faceplate and Topology windows.
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Appendix A. Getting help and technical assistance

If you need help, service, or technical assistance or just want more information
about IBM® products, you will find a wide variety of sources available from
IBM to assist you. This chapter contains information about where to go for
additional information about IBM and IBM products, what to do if you
experience a problem with your xSeries or IntelliStation® system, and whom to
call for service, if it is necessary.

Before you call

Before you call, make sure that you have taken these steps to try to solve the
problem yourself:

v Check all cables to make sure that they are connected.

v Check the power switches to make sure that the system is turned on.

v Use the troubleshooting information in your system documentation, and use
the diagnostic tools that come with your system.

v Go to the IBM Support Web site at http://www.ibm.com/pc/support/ to
check for technical information, hints, tips, and new device drivers.

v Use an IBM discussion forum on the IBM Web site to ask questions.

You can solve many problems without outside assistance by following the
troubleshooting procedures that IBM provides in the online help or in the
publications that are provided with your system and software. The information
that comes with your system also describes the diagnostic tests that you can
perform. Most xSeries and IntelliStation systems, operating systems, and
programs come with information that contains troubleshooting procedures and
explanations of error messages and error codes. If you suspect a software
problem, see the information for the operating system or program.

Using the documentation

Information about your IBM xSeries or IntelliStation system and preinstalled
software, if any, is available in the documentation that comes with your
system. That documentation includes printed books, online books, README
files, and help files. See the troubleshooting information in your system
documentation for instructions for using the diagnostic programs. The
troubleshooting information or the diagnostic programs might tell you that you
need additional or updated device drivers or other software. IBM maintains
pages on the World Wide Web where you can get the latest technical
information and download device drivers and updates. To access these pages,
go to http://www.ibm.com/pc/support/ and follow the instructions. Also,
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you can order publications through the IBM Publications Ordering System at
http://www.elink.ibmlink.ibm.com/public/applications/publications/
cgibin/pbi.cgi.

Getting help and information from the World Wide Web

On the World Wide Web, the IBM Web site has up-to-date information about
IBM xSeries and IntelliStation products, services, and support. The address for
IBM xSeries information is http://www.ibm.com/eserver/xseries/. The
address for IBM IntelliStation information is
http://www.ibm.com/pc/intellistation/.

You can find service information for your IBM products, including supported
options, at http://www.ibm.com/pc/support/. If you click Profile from the
support page, you can create a customized support page. The support page
has many sources of information and ways for you to solve problems,
including:

v Diagnosing problems, using the IBM Online Assistant

v Downloading the latest device drivers and updates for your products

v Viewing Frequently Asked Questions (FAQ)

v Viewing hints and tips to help you solve problems

v Participating in IBM discussion forums

v Setting up e-mail notification of technical updates about your products

Software service and support

Through IBM Support Line, you can get telephone assistance, for a fee, with
usage, configuration, and software problems with xSeries servers, IntelliStation
workstations, and appliances. For information about which products are
supported by Support Line in your country or region, go to
http://www.ibm.com/services/sl/products/.

For more information about Support Line and other IBM services, go to
http://www.ibm.com/services/, or go to http://www.ibm.com/planetwide/
for support telephone numbers.

Hardware service and support

You can receive hardware service through IBM Integrated Technology Services
or through your IBM reseller, if your reseller is authorized by IBM to provide
warranty service. Go to http://www.ibm.com/planetwide/ for support
telephone numbers.
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In the U.S. and Canada, hardware service and support is available 24 hours a
day, 7 days a week. In the U.K., these services are available Monday through
Friday, from 9 a.m. to 6 p.m.
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Appendix B. Warranty information

This section contains information about your warranty period and the service
and support that are provided by your warranty.

Warranty period

The warranty period varies by machine type and country or region.

Contact your place of purchase for warranty service information. Some IBM
Machines are eligible for on-site warranty service depending on the country or
region where service is performed.

Prior to on-site warranty service, you are required to go through problem
determination with an IBM service specialist call center technician.

This paragraph applies only to products with a warranty period of 3 years on
parts and 1 year on labor. A warranty period of 3 years on parts and 1 year on
labor means that IBM will provide warranty service without charge for:
1. parts and labor during the first year of the warranty period
2. parts only, on an exchange basis, in the second and third years of the

warranty period. IBM will charge you for any labor it provides in
performance of the repair or replacement.

The IBM Machine Warranties Web site at
http://www.ibm.com/servers/support/machine_warranties/ contains a
worldwide overview of the IBM Statement of Limited Warranty for IBM
Machines, a glossary of terms used in the Statement of Limited Warranty,
Frequently Asked Questions (FAQ), and links to Product Support Web pages.
The IBM Statement of Limited Warranty is available from this Web site in 29
languages in Portable Document Format (PDF).

Machine - IBM Eserver BladeCenter 2-Port Fibre Channel Switch Module

Country or region Warranty period Service delivery method

Worldwide Parts - 3 years, labor - 3
years

On-site

Problem determination
Prior to on-site warranty service, you are required to go through problem
determination with an IBM service specialist call center technician. The service
specialist will run diagnostic tests on the hardware and check the software.
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Running diagnostics
The IBM service specialist will help you determine whether your equipment is
functioning as specified. It might be necessary to isolate the failing xSeries,
Netfinity®, or IntelliStation system; IBM component; or both from any active
production environment to run diagnostics and perform defect-isolation
programs. You are responsible for making the system, IBM component, or both
available for running diagnostics and defect-isolation programs.

Checking software
The IBM service specialist will help you ensure that the correct BIOS code,
firmware, device drivers, and other supporting IBM software are installed and
correctly configured. It might be necessary to manually gather information
about the relevant software levels or run IBM-approved utility programs to
gather this information. It might be necessary to isolate the failing system from
any active production environment to gather this information. You are
responsible, with assistance from the service specialist, for gathering this
information. The IBM Statement of Limited Warranty does not include on-site
assistance with this activity.

Warranty service and support
With the original purchase of an IBM xSeries or IntelliStation system, you have
access to extensive service and support. During the IBM Machine warranty
period, you may call IBM or your reseller for problem-determination assistance
under the terms of the IBM Statement of Limited Warranty.

The following services are available during the warranty period:

v Problem determination - Trained personnel are available to assist you with
determining if you have a hardware problem and deciding what action is
necessary to fix the problem.

v IBM hardware repair - If the problem is determined to be caused by IBM
hardware under warranty, trained service personnel are available to provide
the applicable level of service, either on-site or at an IBM service center as
determined by IBM.

v Engineering Change management - Occasionally, there might be changes
that are required after a product has been shipped from IBM. In those
instances, IBM will make Engineering Changes (ECs) available that apply to
your hardware.

v Customer replaceable units (CRUs) - Some parts of IBM xSeries and
IntelliStation systems are designated as customer replaceable units. IBM
ships CRUs to you for replacement by you. CRUs include keyboards,
monitors, memory, diskette drives, hard disk drives, and mice (this list is not
inclusive of all CRUs).

The following items are not covered under warranty service:
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v Replacement or use of non-IBM parts. All IBM parts contain a 7-character
identification in the format IBM FRU XXXXXXX.

v Identification of software problem sources.

v Installation of customer replaceable units (CRUs).

v Installation and configuration of BIOS code, firmware, or device drivers that
are designated as customer installable.

See the IBM Statement of Limited Warranty for a full explanation of IBM
warranty terms. Be sure to retain your proof of purchase to obtain warranty
service.

Please have the following information ready when you call:

v The machine type and model of your IBM hardware product (if available)

v Serial numbers of your IBM hardware products

v A description of the problem

v The exact wording of any error messages

v Hardware and software configuration information

International Warranty Service
If you travel with your xSeries or IntelliStation system or relocate it to a
country or region where your system is sold and serviced by IBM or IBM
resellers authorized to perform warranty service, International Warranty
Service (IWS) is available during the warranty period. Eligible IBM systems are
identified by their four-digit machine types.

You can obtain IWS through the service delivery method (such as depot,
carry-in, or on-site) provided in the servicing country or region. Service
methods and procedures vary by country or region, and some service or parts
might not be available in all countries and regions. Service centers in certain
countries or regions might not be able to service all models of a particular
machine type. In addition, some countries or regions might have fees and
restrictions that apply at the time of service.

To determine whether your system is eligible for IWS, go to
http://www.ibm.com/pc/support/ and click Warranty lookup.

Purchasing additional services
During and after the warranty period, you can purchase additional services,
such as support for IBM and non-IBM hardware, operating systems, and
application programs; network setup and configuration; upgraded or extended
hardware repair services; and custom installations. Service availability and
service name might vary by country or region.
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For more information about these services, contact your IBM marketing
representative.
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IBM Statement of Limited Warranty Z125-4753-06 8/2000

Part 1 - General Terms
This Statement of Limited Warranty includes Part 1 - General Terms and Part 2
- Country-unique Terms. The terms of Part 2 replace or modify those of Part 1.
The warranties provided by IBM in this Statement of Limited Warranty apply
only to Machines you purchase for your use, and not for resale, from IBM or
your reseller. The term “Machine” means an IBM machine, its features,
conversions, upgrades, elements, or accessories, or any combination of them.
The term “Machine” does not include any software programs, whether
preinstalled with the Machine, installed subsequently or otherwise. Unless IBM
specifies otherwise, the following warranties apply only in the country where
you acquire the Machine. Nothing in this Statement of Limited Warranty
affects any statutory rights of consumers that cannot be waived or limited by
contract. If you have any questions, contact IBM or your reseller.

The IBM Warranty for Machines: IBM warrants that each Machine 1) is free
from defects in materials and workmanship and 2) conforms to IBM’s Official
Published Specifications (“Specifications”). The warranty period for a Machine
is a specified, fixed period commencing on its Date of Installation. The date on
your sales receipt is the Date of Installation unless IBM or your reseller informs
you otherwise.

If a Machine does not function as warranted during the warranty period, and
IBM or your reseller are unable to either 1) make it do so or 2) replace it with
one that is at least functionally equivalent, you may return it to your place of
purchase and your money will be refunded.

Extent of Warranty: The warranty does not cover the repair or exchange of a
Machine resulting from misuse, accident, modification, unsuitable physical or
operating environment, improper maintenance by you, or failure caused by a
product for which IBM is not responsible. The warranty is voided by removal
or alteration of Machine or parts identification labels.

THESE WARRANTIES ARE YOUR EXCLUSIVE WARRANTIES AND
REPLACE ALL OTHER WARRANTIES OR CONDITIONS, EXPRESS OR
IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OR CONDITIONS OF MERCHANTABILITY AND FITNESS
FOR A PARTICULAR PURPOSE. THESE WARRANTIES GIVE YOU
SPECIFIC LEGAL RIGHTS AND YOU MAY ALSO HAVE OTHER RIGHTS
WHICH VARY FROM JURISDICTION TO JURISDICTION. SOME
JURISDICTIONS DO NOT ALLOW THE EXCLUSION OR LIMITATION
OF EXPRESS OR IMPLIED WARRANTIES, SO THE ABOVE EXCLUSION
OR LIMITATION MAY NOT APPLY TO YOU. IN THAT EVENT, SUCH
WARRANTIES ARE LIMITED IN DURATION TO THE WARRANTY
PERIOD. NO WARRANTIES APPLY AFTER THAT PERIOD.
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Items Not Covered by Warranty: IBM does not warrant uninterrupted or
error-free operation of a Machine. Any technical or other support provided for
a Machine under warranty, such as assistance via telephone with “how-to”
questions and those regarding Machine set-up and installation, will be
provided WITHOUT WARRANTIES OF ANY KIND.

Warranty Service: To obtain warranty service for a Machine, contact IBM or
your reseller. If you do not register your Machine with IBM, you may be
required to present proof of purchase.

During the warranty period, IBM or your reseller, if approved by IBM to
provide warranty service, provides without charge certain types of repair and
exchange service to keep Machines in, or restore them to, conformance with
their Specifications. IBM or your reseller will inform you of the available types
of service for a Machine based on its country of installation. At its discretion,
IBM or your reseller will 1) either repair or exchange the failing Machine and
2) provide the service either at your location or a service center. IBM or your
reseller will also manage and install selected engineering changes that apply to
the Machine.

Some parts of IBM Machines are designated as Customer Replaceable Units
(called “CRUs”), e.g., keyboards, memory, or hard disk drives. IBM ships CRUs
to you for replacement by you. You must return all defective CRUs to IBM
within 30 days of your receipt of the replacement CRU. You are responsible for
downloading designated Machine Code and Licensed Internal Code updates
from an IBM Internet Web site or from other electronic media, and following
the instructions that IBM provides.

When warranty service involves the exchange of a Machine or part, the item
IBM or your reseller replaces becomes its property and the replacement
becomes yours. You represent that all removed items are genuine and
unaltered. The replacement may not be new, but will be in good working order
and at least functionally equivalent to the item replaced. The replacement
assumes the warranty service status of the replaced item. Many features,
conversions, or upgrades involve the removal of parts and their return to IBM.
A part that replaces a removed part will assume the warranty service status of
the removed part.

Before IBM or your reseller exchanges a Machine or part, you agree to remove
all features, parts, options, alterations, and attachments not under warranty
service.

You also agree to
1. ensure that the Machine is free of any legal obligations or restrictions that

prevent its exchange;
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2. obtain authorization from the owner to have IBM or your reseller service a
Machine that you do not own; and

3. where applicable, before service is provided:
a. follow the problem determination, problem analysis, and service request

procedures that IBM or your reseller provides;
b. secure all programs, data, and funds contained in a Machine;
c. provide IBM or your reseller with sufficient, free, and safe access to

your facilities to permit them to fulfill their obligations; and
d. inform IBM or your reseller of changes in a Machine’s location.

IBM is responsible for loss of, or damage to, your Machine while it is 1) in
IBM’s possession or 2) in transit in those cases where IBM is responsible for
the transportation charges.

Neither IBM nor your reseller is responsible for any of your confidential,
proprietary or personal information contained in a Machine which you return
to IBM or your reseller for any reason. You should remove all such information
from the Machine prior to its return.

Limitation of Liability: Circumstances may arise where, because of a default
on IBM’s part or other liability, you are entitled to recover damages from IBM.
In each such instance, regardless of the basis on which you are entitled to
claim damages from IBM (including fundamental breach, negligence,
misrepresentation, or other contract or tort claim), except for any liability that
cannot be waived or limited by applicable laws, IBM is liable for no more than

1. damages for bodily injury (including death) and damage to real property
and tangible personal property; and

2. the amount of any other actual direct damages, up to the charges (if
recurring, 12 months’ charges apply) for the Machine that is subject of the
claim. For purposes of this item, the term “Machine” includes Machine
Code and Licensed Internal Code.

This limit also applies to IBM’s suppliers and your reseller. It is the
maximum for which IBM, its suppliers, and your reseller are collectively
responsible.

UNDER NO CIRCUMSTANCES IS IBM LIABLE FOR ANY OF THE
FOLLOWING: 1) THIRD-PARTY CLAIMS AGAINST YOU FOR DAMAGES
(OTHER THAN THOSE UNDER THE FIRST ITEM LISTED ABOVE); 2)
LOSS OF, OR DAMAGE TO, YOUR RECORDS OR DATA; OR 3) SPECIAL,
INCIDENTAL, OR INDIRECT DAMAGES OR FOR ANY ECONOMIC
CONSEQUENTIAL DAMAGES, LOST PROFITS OR LOST SAVINGS,
EVEN IF IBM, ITS SUPPLIERS OR YOUR RESELLER IS INFORMED OF
THEIR POSSIBILITY. SOME JURISDICTIONS DO NOT ALLOW THE
EXCLUSION OR LIMITATION OF INCIDENTAL OR CONSEQUENTIAL
DAMAGES, SO THE ABOVE LIMITATION OR EXCLUSION MAY NOT
APPLY TO YOU.
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Governing Law: Both you and IBM consent to the application of the laws of
the country in which you acquired the Machine to govern, interpret, and
enforce all of your and IBM’s rights, duties, and obligations arising from, or
relating in any manner to, the subject matter of this Agreement, without regard
to conflict of law principles.

Part 2 - Country-unique Terms
AMERICAS

BRAZIL

Governing Law: The following is added after the first sentence:Any litigation
arising from this Agreement will be settled exclusively by the court of Rio de
Janeiro.

NORTH AMERICA

Warranty Service: The following is added to this Section: To obtain warranty
service from IBM in Canada or the United States, call 1-800-IBM-SERV
(426-7378).

CANADA

Governing Law: The following replaces “laws of the country in which you acquired
the Machine” in the first sentence: laws in the Province of Ontario.

UNITED STATES

Governing Law: The following replaces “laws of the country in which you acquired
the Machine” in the first sentence: laws of the State of New York.

ASIA PACIFIC

AUSTRALIA

The IBM Warranty for Machines: The following paragraph is added to this Section:
The warranties specified in this Section are in addition to any rights you may
have under the Trade Practices Act 1974 or other similar legislation and are
only limited to the extent permitted by the applicable legislation.

Limitation of Liability: The following is added to this Section: Where IBM is in
breach of a condition or warranty implied by the Trade Practices Act 1974 or
other similar legislation, IBM’s liability is limited to the repair or replacement
of the goods or the supply of equivalent goods. Where that condition or
warranty relates to right to sell, quiet possession or clear title, or the goods are
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of a kind ordinarily acquired for personal, domestic or household use or
consumption, then none of the limitations in this paragraph apply.

Governing Law: The following replaces “laws of the country in which you acquired
the Machine” in the first sentence: laws of the State or Territory.

CAMBODIA, LAOS, AND VIETNAM

Governing Law: The following replaces “laws of the country in which you acquired
the Machine” in the first sentence:laws of the State of New York.

The following is added to this Section: Disputes and differences arising out of or
in connection with this Agreement shall be finally settled by arbitration which
shall be held in Singapore in accordance with the rules of the International
Chamber of Commerce (ICC). The arbitrator or arbitrators designated in
conformity with those rules shall have the power to rule on their own
competence and on the validity of the Agreement to submit to arbitration. The
arbitration award shall be final and binding for the parties without appeal and
the arbitral award shall be in writing and set forth the findings of fact and the
conclusions of law.

All proceedings shall be conducted, including all documents presented in such
proceedings, in the English language. The number of arbitrators shall be three,
with each side to the dispute being entitled to appoint one arbitrator.

The two arbitrators appointed by the parties shall appoint a third arbitrator
before proceeding upon the reference. The third arbitrator shall act as chairman
of the proceedings. Vacancies in the post of chairman shall be filled by the
president of the ICC. Other vacancies shall be filled by the respective
nominating party. Proceedings shall continue from the stage they were at when
the vacancy occurred.

If one of the parties refuses or otherwise fails to appoint an arbitrator within 30
days of the date the other party appoints its, the first appointed arbitrator shall
be the sole arbitrator, provided that the arbitrator was validly and properly
appointed.

The English language version of this Agreement prevails over any other
language version.

HONG KONG AND MACAU

Governing Law: The following replaces “laws of the country in which you acquired
the Machine” in the first sentence: laws of Hong Kong Special Administrative
Region.
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INDIA

Limitation of Liability: The following replaces items 1 and 2 of this Section:
1. liability for bodily injury (including death) or damage to real property and

tangible personal property will be limited to that caused by IBM’s
negligence;

2. as to any other actual damage arising in any situation involving
nonperformance by IBM pursuant to, or in any way related to the subject
of this Statement of Limited Warranty, IBM’s liability will be limited to the
charge paid by you for the individual Machine that is the subject of the
claim.

JAPAN

Governing Law: The following sentence is added to this Section:Any doubts
concerning this Agreement will be initially resolved between us in good faith
and in accordance with the principle of mutual trust.

NEW ZEALAND

The IBM Warranty for Machines: The following paragraph is added to this Section:
The warranties specified in this Section are in addition to any rights you may
have under the Consumer Guarantees Act 1993 or other legislation which
cannot be excluded or limited. The Consumer Guarantees Act 1993 will not
apply in respect of any goods which IBM provides, if you require the goods
for the purposes of a business as defined in that Act.

Limitation of Liability: The following is added to this Section: Where Machines
are not acquired for the purposes of a business as defined in the Consumer
Guarantees Act 1993, the limitations in this Section are subject to the
limitations in that Act.

PEOPLE’S REPUBLIC OF CHINA (PRC)

Governing Law: The following replaces this Section: Both you and IBM consent to
the application of the laws of the State of New York (except when local law
requires otherwise) to govern, interpret, and enforce all your and IBM’s rights,
duties, and obligations arising from, or relating in any manner to, the subject
matter of this Agreement, without regard to conflict of law principles.

Any disputes arising from or in connection with this Agreement will first be
resolved by friendly negotiations, failing which either of us has the right to
submit the dispute to the China International Economic and Trade Arbitration
Commission in Beijing, the PRC, for arbitration in accordance with its
arbitration rules in force at the time. The arbitration tribunal will consist of
three arbitrators. The language to be used therein will be English and Chinese.
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An arbitral award will be final and binding on all the parties, and will be
enforceable under the Convention on the Recognition and Enforcement of
Foreign Arbitral Awards (1958).

The arbitration fee will be borne by the losing party unless otherwise
determined by the arbitral award.

During the course of arbitration, this Agreement will continue to be performed
except for the part which the parties are disputing and which is undergoing
arbitration.

EUROPE, MIDDLE EAST, AFRICA (EMEA)

THE FOLLOWING TERMS APPLY TO ALL EMEA COUNTRIES: The terms of
this Statement of Limited Warranty apply to Machines purchased from IBM or
an IBM reseller.

Warranty Service: If you purchase an IBM Machine in Austria, Belgium,
Denmark, Estonia, Finland, France, Germany, Greece, Iceland, Ireland, Italy,
Latvia, Lithuania, Luxembourg, Netherlands, Norway, Portugal, Spain,
Sweden, Switzerland or United Kingdom, you may obtain warranty service for
that Machine in any of those countries from either (1) an IBM reseller
approved to perform warranty service or (2) from IBM. If you purchase an
IBM Personal Computer Machine in Albania, Armenia, Belarus, Bosnia and
Herzegovina, Bulgaria, Croatia, Czech Republic, Georgia, Hungary,
Kazakhstan, Kirghizia, Federal Republic of Yugoslavia, Former Yugoslav
Republic of Macedonia (FYROM), Moldova, Poland, Romania, Russia, Slovak
Republic, Slovenia, or Ukraine, you may obtain warranty service for that
Machine in any of those countries from either (1) an IBM reseller approved to
perform warranty service or (2) from IBM.

If you purchase an IBM Machine in a Middle Eastern or African country, you
may obtain warranty service for that Machine from the IBM entity within the
country of purchase, if that IBM entity provides warranty service in that
country, or from an IBM reseller, approved by IBM to perform warranty service
on that Machine in that country. Warranty service in Africa is available within
50 kilometers of an IBM authorized service provider. You are responsible for
transportation costs for Machines located outside 50 kilometers of an IBM
authorized service provider.

Governing Law: The applicable laws that govern, interpret and enforce rights,
duties, and obligations of each of us arising from, or relating in any manner to,
the subject matter of this Statement, without regard to conflict of laws
principles, as well as Country-unique terms and competent court for this
Statement are those of the country in which the warranty service is being
provided, except that in 1) Albania, Bosnia-Herzegovina, Bulgaria, Croatia,
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Hungary, Former Yugoslav Republic of Macedonia, Romania, Slovakia,
Slovenia, Armenia, Azerbaijan, Belarus, Georgia, Kazakhstan, Kyrgyzstan,
Moldova, Russia, Tajikistan, Turkmenistan, Ukraine, and Uzbekistan, the laws
of Austria apply; 2) Estonia, Latvia, and Lithuania, the laws of Finland apply;
3) Algeria, Benin, Burkina Faso, Cameroon, Cape Verde, Central African
Republic, Chad, Congo, Djibouti, Democratic Republic of Congo, Equatorial
Guinea, France, Gabon, Gambia, Guinea, Guinea-Bissau, Ivory Coast, Lebanon,
Mali, Mauritania, Morocco, Niger, Senegal, Togo, and Tunisia, this Agreement
will be construed and the legal relations between the parties will be
determined in accordance with the French laws and all disputes arising out of
this Agreement or related to its violation or execution, including summary
proceedings, will be settled exclusively by the Commercial Court of Paris; 4)
Angola, Bahrain, Botswana, Burundi, Egypt, Eritrea, Ethiopia, Ghana, Jordan,
Kenya, Kuwait, Liberia, Malawi, Malta, Mozambique, Nigeria, Oman, Pakistan,
Qatar, Rwanda, Sao Tome, Saudi Arabia, Sierra Leone, Somalia, Tanzania,
Uganda, United Arab Emirates, United Kingdom, West Bank/Gaza, Yemen,
Zambia, and Zimbabwe, this Agreement will be governed by English Law and
disputes relating to it will be submitted to the exclusive jurisdiction of the
English courts; and 5) in Greece, Israel, Italy, Portugal, and Spain any legal
claim arising out of this Statement will be brought before, and finally settled
by, the competent court of Athens, Tel Aviv, Milan, Lisbon, and Madrid,
respectively.

THE FOLLOWING TERMS APPLY TO THE COUNTRY SPECIFIED:

AUSTRIA AND GERMANY

The IBM Warranty for Machines: The following replaces the first sentence of the
first paragraph of this Section: The warranty for an IBM Machine covers the
functionality of the Machine for its normal use and the Machine’s conformity
to its Specifications.

The following paragraphs are added to this Section:

The minimum warranty period for Machines is six months. In case IBM or
your reseller is unable to repair an IBM Machine, you can alternatively ask for
a partial refund as far as justified by the reduced value of the unrepaired
Machine or ask for a cancellation of the respective agreement for such Machine
and get your money refunded.

Extent of Warranty: The second paragraph does not apply.

Warranty Service: The following is added to this Section: During the warranty
period, transportation for delivery of the failing Machine to IBM will be at
IBM’s expense.
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Limitation of Liability: The following paragraph is added to this Section: The
limitations and exclusions specified in the Statement of Limited Warranty will
not apply to damages caused by IBM with fraud or gross negligence and for
express warranty.

The following sentence is added to the end of item 2: IBM’s liability under this item
is limited to the violation of essential contractual terms in cases of ordinary
negligence.

EGYPT

Limitation of Liability: The following replaces item 2 in this Section: as to any
other actual direct damages, IBM’s liability will be limited to the total amount
you paid for the Machine that is the subject of the claim. For purposes of this
item, the term “Machine” includes Machine Code and Licensed Internal Code.

Applicability of suppliers and resellers (unchanged).

FRANCE

Limitation of Liability: The following replaces the second sentence of the first
paragraph of this Section:In such instances, regardless of the basis on which you
are entitled to claim damages from IBM, IBM is liable for no more than: (items
1 and 2 unchanged).

IRELAND

Extent of Warranty: The following is added to this Section: Except as expressly
provided in these terms and conditions, all statutory conditions, including all
warranties implied, but without prejudice to the generality of the foregoing all
warranties implied by the Sale of Goods Act 1893 or the Sale of Goods and
Supply of Services Act 1980 are hereby excluded.

Limitation of Liability: The following replaces items one and two of the first
paragraph of this Section:1. death or personal injury or physical damage to your
real property solely caused by IBM’s negligence; and 2. the amount of any
other actual direct damages, up to 125 percent of the charges (if recurring, the
12 months’ charges apply) for the Machine that is the subject of the claim or
which otherwise gives rise to the claim.

Applicability of suppliers and resellers (unchanged).

The following paragraph is added at the end of this Section: IBM’s entire liability
and your sole remedy, whether in contract or in tort, in respect of any default
shall be limited to damages.

Appendix B. Warranty information 65



ITALY

Limitation of Liability: The following replaces the second sentence in the first
paragraph:In each such instance unless otherwise provided by mandatory law,
IBM is liable for no more than: 1. (unchanged) 2. as to any other actual damage
arising in all situations involving nonperformance by IBM pursuant to, or in
any way related to the subject matter of this Statement of Warranty, IBM’s
liability, will be limited to the total amount you paid for the Machine that is
the subject of the claim. Applicability of suppliers and resellers (unchanged).

The following replaces the third paragraph of this Section: Unless otherwise
provided by mandatory law, IBM and your reseller are not liable for any of the
following: (items 1 and 2 unchanged) 3) indirect damages, even if IBM or your
reseller is informed of their possibility.

SOUTH AFRICA, NAMIBIA, BOTSWANA, LESOTHO AND SWAZILAND

Limitation of Liability: The following is added to this Section: IBM’s entire
liability to you for actual damages arising in all situations involving
nonperformance by IBM in respect of the subject matter of this Statement of
Warranty will be limited to the charge paid by you for the individual Machine
that is the subject of your claim from IBM.

UNITED KINGDOM

Limitation of Liability: The following replaces items 1 and 2 of the first paragraph
of this Section:
1. death or personal injury or physical damage to your real property solely

caused by IBM’s negligence;
2. the amount of any other actual direct damages or loss, up to 125 percent of

the charges (if recurring, the 12 months’ charges apply) for the Machine
that is the subject of the claim or which otherwise gives rise to the claim;

The following item is added to this paragraph: 3. breach of IBM’s obligations
implied by Section 12 of the Sale of Goods Act 1979 or Section 2 of the Supply
of Goods and Services Act 1982.

Applicability of suppliers and resellers (unchanged).

The following is added to the end of this Section: IBM’s entire liability and your
sole remedy, whether in contract or in tort, in respect of any default shall be
limited to damages.
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Appendix C. Notices

This publication was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this
document in other countries. Consult your local IBM representative for
information on the products and services currently available in your area. Any
reference to an IBM product, program, or service is not intended to state or
imply that only that IBM product, program, or service may be used. Any
functionally equivalent product, program, or service that does not infringe any
IBM intellectual property right may be used instead. However, it is the user’s
responsibility to evaluate and verify the operation of any non-IBM product,
program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not give you
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785
U.S.A.

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE. Some jurisdictions do not allow disclaimer of
express or implied warranties in certain transactions, therefore, this statement
may not apply to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this publication to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those
Web sites. The materials at those Web sites are not part of the materials for this
IBM product, and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.
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Edition notice

© COPYRIGHT INTERNATIONAL BUSINESS MACHINES
CORPORATION, 2003. All rights reserved.

Note to U.S. Government Users — Documentation related to restricted rights
— Use, duplication or disclosure is subject to restrictions set forth in GSA ADP
Schedule Contract with IBM Corp.

Trademarks

The following terms are trademarks of International Business Machines
Corporation in the United States, other countries, or both:

Active Memory Predictive Failure
Analysis

Active PCI PS/2
Active PCI-X ServeRAID
Alert on LAN ServerGuide
BladeCenter
C2T Interconnect ServerProven
Chipkill TechConnect
EtherJet Tivoli
e-business logo Tivoli Enterprise
FlashCopy Update Connector
IBM Wake on LAN
IntelliStation XA-32
Light Path Diagnostics XA-64
NetBAY X-Architecture
Netfinity XceL4
NetView XpandOnDemand
OS/2 WARP xSeries

Lotus, Lotus Notes, SmartSuite, and Domino are trademarks of Lotus
Development Corporation and/or IBM Corporation in the United States, other
countries, or both.

ActionMedia, LANDesk, MMX, Pentium, and ProShare are trademarks of Intel
Corporation in the United States, other countries, or both.

Microsoft, Windows, and Windows NT are trademarks of Microsoft
Corporation in the United States, other countries, or both.
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UNIX is a registered trademark of The Open Group in the United States and
other countries.

Java and all Java-based trademarks and logos are trademarks or registered
trademarks of Sun Microsystems, Inc. in the United States, other countries, or
both.

Linux is a registered trademark of Linus Torvalds.

Other company, product, or service names may be trademarks or service marks
of others.

Important notes

Processor speeds indicate the internal clock speed of the microprocessor; other
factors also affect application performance.

CD-ROM drive speeds list the variable read rate. Actual speeds vary and are
often less than the maximum possible.

When referring to processor storage, real and virtual storage, or channel
volume, KB stands for approximately 1000 bytes, MB stands for approximately
1 000 000 bytes, and GB stands for approximately 1 000 000 000 bytes.

When referring to hard disk drive capacity or communications volume, MB
stands for 1 000 000 bytes, and GB stands for 1 000 000 000 bytes. Total
user-accessible capacity may vary depending on operating environments.

Maximum internal hard disk drive capacities assume the replacement of any
standard hard disk drives and population of all hard disk drive bays with the
largest currently supported drives available from IBM.

Maximum memory may require replacement of the standard memory with an
optional memory module.

IBM makes no representation or warranties regarding non-IBM products and
services that are ServerProven®, including but not limited to the implied
warranties of merchantability and fitness for a particular purpose. These
products are offered and warranted solely by third parties.

IBM makes no representations or warranties with respect to non-IBM products.
Support (if any) for the non-IBM products is provided by the third party, not
IBM.

Some software may differ from its retail version (if available), and may not
include user manuals or all program functionality.
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Electronic emission notices

Federal Communications Commission (FCC) statement
Note: This equipment has been tested and found to comply with the limits for
a Class A digital device, pursuant to Part 15 of the FCC Rules. These limits are
designed to provide reasonable protection against harmful interference when
the equipment is operated in a commercial environment. This equipment
generates, uses, and can radiate radio frequency energy and, if not installed
and used in accordance with the instruction manual, may cause harmful
interference to radio communications. Operation of this equipment in a
residential area is likely to cause harmful interference, in which case the user
will be required to correct the interference at his own expense.

Properly shielded and grounded cables and connectors must be used in order
to meet FCC emission limits. Properly shielded and grounded cables and
connectors must be used in order to meet FCC emission limits.IBM is not
responsible for any radio or television interference caused by using other than
recommended cables and connectors or by using other than recommended
cables and connectors or by unauthorized changes or modifications to this
equipment. Unauthorized changes or modifications could void the user’s
authority to operate the equipment.

This device complies with Part 15 of the FCC Rules. Operation is subject to the
following two conditions: (1) this device may not cause harmful interference,
and (2) this device must accept any interference received, including
interference that may cause undesired operation.

Industry Canada Class A emission compliance statement
This Class A digital apparatus complies with Canadian ICES-003.

Avis de conformité à la réglementation d’Industrie Canada

Cet appareil numérique de la classe A est conforme à la norme NMB-003 du
Canada.

Australia and New Zealand Class A statement
Attention: This is a Class A product. In a domestic environment this product
may cause radio interference in which case the user may be required to take
adequate measures.

70 IBM Eserver BladeCenter 2-Port Fibre Channel Switch Module: Installation Guide



United Kingdom telecommunications safety requirement
Notice to Customers

This apparatus is approved under approval number NS/G/1234/J/100003 for
indirect connection to public telecommunication systems in the United
Kingdom.

European Union EMC Directive conformance statement
This product is in conformity with the protection requirements of EU Council
Directive 89/336/EEC on the approximation of the laws of the Member States
relating to electromagnetic compatibility. IBM cannot accept responsibility for
any failure to satisfy the protection requirements resulting from a
nonrecommended modification of the product, including the fitting of non-IBM
option cards.

This product has been tested and found to comply with the limits for Class A
Information Technology Equipment according to CISPR 22/European Standard
EN 55022. The limits for Class A equipment were derived for commercial and
industrial environments to provide reasonable protection against interference
with licensed communication equipment.

Attention: This is a Class A product. In a domestic environment this product
may cause radio interference in which case the user may be required to take
adequate measures.

Taiwanese Class A warning statement
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Japanese Voluntary Control Council for Interference (VCCI)
statement
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